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 سارا کریم زاده    :تهیه کننده        

 سانیراطلاع   کارشناسی ارشد کتابداری و 

 کتابخانه دانشکده پزشکی شیرازمسئول  

 

 فهرست عناوین 

 معرفی اندنوت

 چگونه یک کتابخانه شخصی بسازیم؟

 مروری بر پنجره کتابخانه 

  اطلاعات به نرم افزار ورود

 مدیریت اطلاعات وارد شده به اندنوت 

 آشنایی با نوار ابزار اندنوت در محیط ورد 

 رفرنس نویسی  (Style)انتخاب یک سبک 

 ویرایش و مدیریت استنادها در ورد 

  

   معرفی اندنوت 

یریت منابع، اطلاعات و استنادها در روند پژوهش  نرم افزار اندنوت یکی از بهترین و جامع ترین نرم افزارهای مد 

است که امروزه به طور گسترده توسط پژوهشگران استفاده می شود. نرم افزار اندنوت محیط حرفه ای، هوشمند  

( و یا با استفاده  Onlineو ساده ای را در اختیار کاربران قرار می دهد. این نرم افزار با اتصال به اینترنت )به صورت  

( می تواند اطلاعات مربوط به مقالات و یا پایان نامه ها را با  Offlineاز کتابخانه اندنوت ذخیره شده )به صورت  

فرمت های گوناگون دریافت و رفرنس گذاری نماید. در کتابخانه اندنوت تمامی ویژگی های مقالات از جمله اسامی  

ال انتشار، نام مجله و ... در اختیار کاربران قرار می گیرد. با کمک این نرم افزار  نویسندگان، عنوان، زبان، چکیده، س 
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 استنادهای مقالات خود را در قالبی دلخواه و یکسان مرتب کنید.        •

 در میان منابع پژوهشی خود به راحتی به جستجو بپردازید.        •

 نمودارها، و متن مقالات مورد نیاز خود را ذخیره نمایید.تصاویر، جداول،         •

 هم زمان با نوشتن مقاله، استنادها را با هر شیوه دلخواه به متن اضافه کنید.        •

 نسخه جدید اندنوت دارای ویژگی های جدید زیر است:  

 رابط کاربری مدرن دوباره طراحی شد  .1

 ل قرار می دهد خلاصه مرجع که اطلاعات مهم را در درجه او .2

 را دوباره طراحی کرد  PDF با استفاده از ابزار حاشیه نویسی ، مشاهده گر  .3

 خود  Web of Science ایجاد گزارش استنادی از اندنوت دسک تاپ بوسیله اشتراک .4

 read-and-writeیا  read-onlyاشتراک گذاری کل کتابخانه با دسترسی فقط  .5

 دیگران کل کتابخانه با  اشتراک گذاری  .6

 یافتن و اعمال خودکار به روزرسانی همه منابع  .7

 

 روش نصب نرم افزار   

پیش از این که کار با نرم افزار را شروع نمایید لازم است آن را بر روی کامپیوتر خود نصب کنید. می توانید فایل  

  آدرس نصب این نرم افزار را از کتابخانه واحد های مختلف دانشگاه )دانشکده یا بیمارستان( دریافت و یا از این  

در کنار هم قرار دارد. با دو بار کلیک بر    Crackدانلود نمایید. فایل اجرایی نرم افزار اندنوت و فولدر محتوی فایل  

 روی فایل اجرایی، نرم افزار را نصب نمایید.  

https://soft98.ir/software/engineering/2431-%D8%A7%D9%86%D8%AF%D9%86%D9%88%D8%AA.html


 

 

را انتخاب کرده و مراحل نصب را ادامه    "I would like a ۳۰ day free trial"در جریان نصب گزینه   

دهید تا نرم افزار به طور کامل نصب شود )نکته مهم و قابل ذکر این است که هنگام نصب اندنوت نرم افزار ورد  

 .(.نباید باز باشد 

 

  

را باز نموده و فایل درون آن را جایگزین فایلی    "Crack"پس از اتمام نصب برای شکستن قفل نرم افزار، پوشه  

اندنوت نصب  محل  در  نام  همین  در   با  فرض  پیش  صورت  به  پوشه  این  محل     C:\Programنمایید. 

file\Endnote ۲۰    .باشد   می 

 



 

 چگونه یک کتابخانه شخصی بسازیم؟  

درست همانند یک کتابخانه، تعداد زیادی از منابع و ماخذ را    Endnote Libraryکتابخانه شخصی اندنوت یا  

 ذخیره می نماید. برای ساختن یک کتابخانه شخصی مراحل زیر را انجام دهید. 

 .را اجرا نمایید   Start> All program>Endnoteاز منوی      .۱

  .را انتخاب کنید  Newگزینه  Fileدر پنجره اندنوت برای ساختن یک فضای کار جدید، از منوی        .۲

 

 
 

مکان مورد نظر برای ذخیره کردن فایلتان را انتخاب کنید؛ در    Save inدر پنجره جدید، در قسمت        .۳ 

 عنوانی برای کتابخانه شخصی خود برگزینید.  File Nameقسمت 

 کلیک نمایید.  Saveروی کلید      .۴



 

محل    Dataدارد. پوشه    "Data"نکته: کتابخانه شخصی شما، در کنار خود پوشه ای با همان نام و با پسوند  

رای دسترسی به  نموده اید. لذا ب  (attach)ذخیره کلیه فایل هایی است که به منابع موجود در کتابخانه ضمیمه  

 را نیز همراه آن جابجا نمایید. Dataفایل های ضمیمه، لازم است هنگام جابجا نمودن کتابخانه شخصی پوشه 

   

 کتابخانهمروری بر پنجره 

زمانی که شما یک پنجره کتابخانه را باز می کنید، لیستی از همه رفرنس ها ی موجود در کتابخانه نمایش داده  

 فضای کار )پنل( است:   ۴می شود. پنجره کتابخانه شامل  

 

 

  



 

: گروه های مختلف رفرنس را برای بازیابی آسان نمایش می دهد. شامل گروه سفارشی    پنل گروه ها .1

(My Group)  گروه هوشمند ،(Smart group)  گروه ترکیبی ،(Combination group)    و

..... 

: این پنل یک لیست چند ستونی از رفرنس ها را نمایش می دهد. به صورت پیش  پنل لیست رفرنس ها .2

 رد زیر را نمایش می دهند:فرض ستون ها موا

 جهت نشان دادن اینکه رفرنس شامل فایل ضمیمه است. "گیره" آیکون         •

 نام خانوادگی نویسنده و نام کوچک         •

 سال         •

 عنوان         •

 رتبه بندی         •

 نام مجله         •

 نوع رفرنس         •

•        URL 

 روزآمدسازیآخرین         •

 

 



 

 نکته: 

شما می توانید نظم فیلدهایی که در لیست منابع هستند را تغییر دهید. برای این کار روی تب         •

و ... کلیک نمایید تا تنظیمات آن بخش را به صورت   Author, Yearهای بالای هر بخش مانند 

  .صعودی یا نزولی تغییر دهد 

 <Editهمچنین می توانید فیلد های موجود در لیست را با استفاده از منوی        •

Preferences> Display fields  تغییر دهید. 

 : این پنل موارد زیر را نمایش می دهد: پنل زبانه ها )تب ها( .3

با انتخاب هر یک از رفرنس های موجود در پنجره کتابخانه، و با کلیک در قسمت    : Summaryتب         •

فعال می گردد. در این قسمت اطلاعات مختصری از رفرنس مانند عنوان،    Summaryسمت راست پنل  

 نام نویسندگان و ... به همراه لینک دسترسی به صفحه رفرنس نمایش داده می شود.  

این قسمت به شما نشان می دهد که چگونه یک رفرنس با یک استایل خاص در  : در  Previewتب           •

 ورد ظاهر می شود. 

فایل  نکته        در صورتی که   :PDF    تب بالای  قسمت  باشد در  نظر ضمیمه شده  مورد  رفرنس  به  مقاله 

summary   نشان داده میشود. با کلیک بر روی نام آن می توانید فایلPDF   را باز نمایید و در صورت

نیاز در این فایل قسمتهایی را هایلایت نموده و یا یادداشت گذاری نمایید. بعد از بستن پنجره تغییرات را  

 ذخیره نمایید.



 

 
    

در پنل سمت راست کلیک نمایید و یا بر روی    Edit: برای فعال نمودن این تب، روی گزینه  Editتب           •

 را انتخاب نمایید.   Edit referenceرفرنس مورد نظر کلیک راست و گزینه  

در پنل سمت راست می توانید در بین فیلدهای رفرنس جابجا شوید و در صورت نیاز ویرایش لازم را انجام  

 را بزنید تا تغییرات ذخیره گردد.  saveکار گزینه  دهید. در پایان

، می توان جهت جستجو در    Online search: از این تب علاوه بر جستجو در قسمت  تب جستجو      .۴ 

رفرنس های موجود در کتابخانه شخصی نیز استفاده نمود. به صورت پیش فرض پنل جستجوی ساده در بالای  

پنجره اندنوت قرار دارد که می توانید کلیدواژه خود را در این قسمت وارد نمایید. در صورت نیاز به جستجوی  

 را انتخاب نمایید تا امکانات بیشتری برای شما فراهم گردد.  Advanced searchپیشرفته می توانید گزینه 

 پنل جستجوی پیشرفته شامل موارد زیر است:

 لیست عملگرهای منطقی     .۱

 لیست فیلدها     .۲

 لیست تطبیق      .۳



 

 زمینه های جستجو      .۴

 نکاتی در باره جستجو:

که به رفرنس ها متصل شده اند را فراهم می کند. به   PDFاندنوت امکان جستجو در فایل های         •

را انتخاب کرده و کلیدواژه   Any field+ Pdf with notesاین ترتیب که در پنل جستجو فیلد 

د  آنها این کلیدواژه موجود باشد بازیابی خواه PDFمورد نظر را وارد کنید. رفرنس هایی که در فایل  

 .گردید 

می توان استراتژی جستجوی خود در اندنوت را ذخیره نمایید. برای اینکار بعد از وارد کردن         •

را انتخاب نمایید. به این ترتیب   Option> Save searchکلیدواژه ها و تعیین فیلدها از گزینه  

جستجوی قبلی  برای بازیابی استراتژی   Option> Load searchدفعات بعد می توان از گزینه  

 .استفاده نمود

 مرتب کردن رفرنس ها 

شما می توانید رفرنس ها را با کلیک کردن بر روی نوار بالای هر ستون مانند عنوان، نویسنده، سال و ... مرتب  

 کنید.

 
    

 



 

 انتخاب رفرنس ها

 راه های مختلفی برای انتخاب رفرنس وجود دارد مانند:

 رفرنسکلیک کردن بر روی      .۱

 استفاده از کلیدهای حرکتی بر روی کیبورد      .۲

 تایپ کردن چند حرف از کلمات موجود در فیلدهای رفرنس مورد نظر      .۳

 تنظیمات

    : برای انجام این تنظیمات یا از گزینهSync Libraryتنظیمات همگام سازی        

استفاده نمایید. این تنظیمات به شما اجازه   Edit>Preferences>Syncدر پنل گروه ها و یا از منوی  

  .می دهد نام کاربری و رمز عبور خود را که مربوط به اندنوت وب است، ذخیره نمایید 

  

 



 

 PDF handling این تنظیمات امکان تعریف تغییر نام خودکار اسناد :PDF   را که به کتابخانه اندنوت وارد

ها نامهای قابل    PDFمی نمایید، فراهم می کند. با این کار شما می توانید به منظور سازماندهی بهتر ، برای  

 جستجو تعریف نمایید.

 را انتخاب نمایید. Edit> Preferences> PDF handlingابتدا       .۱

خود را انجام دهید. به صورت پیش فرض    PDFنظر بر روی اسناد   در پنل بالا می توانید تغییرات مورد      .۲

انتخاب شده است. گزینه های دیگر به شما اجازه می دهد یک روش شخصی   Don’t renameگزینه 

 بسازید.  PDFبرای تغییر نام اسناد  

مت  نام دارد. در این قس "PDF auto import folder". گزینه دیگری که در این قسمت وجود دارد ۳

   PDFبه این فولدر، آن    PDFشما میتوانید یک فولدر روی کامپیوترتان مشخص نمایید که با ورود هر  

در پنل    Preferences> PDF handlingوارد کتابخانه اندنوت شود. برای تنظیم این بخش در پنجره  

PDF auto import folder   گزینهEnable automatic importing   را تیک بزنید و فولدر

تغییرات را   OKانتخاب نمایید. با کلیک بر روی  Select folderمورد نظر خود را با کلیک بر روی گزینه 

 ذخیره نمایید.

       Display field  با استفاده از این قسمت در پنجره :Preferences    می توانید ترتیب نمایش فیلدها

 ل و....( در پنل رفرنس در پنجره اندنوت را تنظیم نمایید.)نویسنده، عنوان، سال, نام ژورنا



 

 

  

Display font  در این بخش می توانید نوع فونت و سایز حروف در بخش های مختلف پنجره اندنوت را :

  تنظیم نمایید.

    

   ورود اطلاعات به نرم افزار 

   

 .ورود اطلاعات به صورت دستی ۱

شخصی خود را ساختید، نوبت به ورود اطلاعات منابع می رسد. چند روش برای ورود  بعد از این که کتابخانه  

اطلاعات به نرم افزار اندنوت وجود دارد. اولین روش ورود اطلاعات، به صورت دستی است. توصیه می شود تنها  

ه شخصی وارد نمایید.  در صورتی یک رکورد را دستی وارد نمایید که نتوانید اطلاعات آن را از اینترنت به کتابخان

 :برای ورود اطلاعات یک رکورد به صورت دستی 

را انتخاب نمایید یا در نوار ابزار بالای پنل   New Referenceگزینه   Referenceاز منوی        •

 .را انتخاب کنید     لیست رفرنس ها



 

نوع ماخذ )برای مثال   Reference Typeبعد از باز شدن فرم ورود اطلاعات، ابتدا در قسمت     •

book, journal article  و...( را انتخاب نمایید. اطلاعات درخواستی فرم، مطابق با نوع ماخذ

 .انتخابی تغییر می کند 

 .یید در هر قسمت از فرم، با کلیک بر روی هر خانه اطلاعات را تایپ نما      •

و یا با بستن پنجره فرم، از شما سوال می   Close referenceگزینه   Fileبا انتخاب منوی        •

را انتخاب نمایید. این ماخذ در کتابخانه شما ذخیره می   Yesشود که تغییرات ذخیره شود، گزینه  

 .شود

 نکات مهم: 

یک فاصله و بعد از آن نام کوچک  ابتدا نام خانوادگی نویسنده، سپس یک کاما و  Authorدر فیلد      •

را   ()یا مخفف آن به همراه یک نقطه( ویک فاصله و سپس نام میانی )یا مخفف آن به همراه یک نقطه

 .بگذارید 

در یک سطر   Enterدر صورتی که منبع دارای چند نویسنده می باشد، هر نویسنده را با زدن کلید        •

 .بنویسید 

 .وارد نمایید  yearو روز را بنویسید. سال را جداگانه در فیلد  تنها ماه "Date"در فیلد        •

 .در هیچکدام از فیلدها سطر خالی وارد ننمایید       •

 .جستجو در پایگاه اطلاعاتی/ ذخیره/ انتقال به کتابخانه شخصی۲

ابتدا جستجوی خود را در پایگاه اطلاعاتی مورد نظرتان انجام دهید. سپس نتایج دلخواه را به صورت یک فایل  

 قابل خواندن توسط نرم افزار اندنوت ذخیره نمایید. در پایان این اطلاعات را به کتابخانه شخصی خود انتقال دهید.  

 PubMedانتقال اطلاعات از پایگاه    . ۳

 شوید. PubMedوارد سایت        •

 جستجوی خود را انجام دهید.        •

 منابع مورد نظر خود را از نتایج جستجو انتخاب نمایید.       •



 

 

 
 
 

را    Pubmedگزینه    Formatرا کلیک نمایید. از قسمت    Saveدر بالای صفحه جستجو، گزینه          •

 را کلیک کنید.  Creat Fileانتخاب نمایید و گزینه  

 را از پنجره مورد نظر انتخاب نمایید و فایل را ذخیره کنید. Saveگزینه        •

 اکنون نوبت به انتقال داده ها به اندنوت فرا رسیده است. برای این کار:         •

  Import> Fileبر روی گزینه    Fileالف( نرم افزار را اجرا و کتابخانه شخصی تان را باز نمایید. از منوی  

 باز می شود.  Import Fileرا انتخاب نمایید. پنجره  



 

 
 

فیلتر مناسب را انتخاب نمایید. نام پایگاهی که جستجو را در آن انجام داده   Import Optionب( در قسمت  

 Importدر قسمت  Pubmedاید و نتایج را از آن ذخیره نموده اید، بیابید. جهت انتقال اطلاعات از 

option  گزینهPubmed(NLM)  را انتخاب نمایید. 

را برای حذف موارد تکراری انتخاب   Discarde duplicatesگزینه   Duplicatesدر قسمت      (ج 

 .نمایید 

  .، اطلاعات منابع با سرعت به کتابخانه شخصی شما انتقال می یابد Importبا کلیک بر روی گزینه      (ح 

 Google Scholarانتقال نتایج جستجو از سایت      

 Bibliographyبرای این کار ابتدا باید به قسمت تنظیمات این سایت وارد شوید. در قسمت       •

manager    یا مدیر فهرست منابع گزینهShow links to import citations into   را روی

 .را کلیک نمایید  Saveاندنوت تنظیم نمایید و کلید  

در زیر هر رفرنس را   Import into Endnoteبعد از جستجو ی کلید واژه مورد نظر گزینه             •

  .را بزنید  Saveکلیک نمایید و کلید 

از   Import optionاست، فقط در قسمت   Pubmedمراحل انتقال اطلاعات مانند انتقال از         •

 .استفاده نمایید  Refer/BibIXگزینه  

موجود نبود، می    Import Optionاگر نام پایگاهی که نتایج را از آن ذخیره می نمایید در لیست      :نکته

( ris.۱۰۷۷)مانند   ris.برای فایل هایی با پسوند    Reference Manager (RIS)توانید از فیلتر 



 

یا   با پسوند    Endnote Import و  فایل هایی  انتقال  ( جهت  citation.enwمانند  )  enw.برای 

 اطلاعات به اندنوت استفاده نمایید. 

 نتایج جستجو از پایگاه های اطلاعاتی به کتابخانه شخصی (Direct export). انتقال مستقیم ۳

(  … ,ISI, Scopus, Pubmed, Elsevier, Springerبسیاری از پایگاه های اطلاعاتی مقالات )مانند  

به   را  نتایج جستجو  انتقال مستقیم  انجام  توانایی  با  روش همزمان  این  در  نمایند.  می  فراهم  کتابخانه شخصی 

 جستجو لازم است که فایل اندنوت شما باز باشد. 

 Pubmedانتقال نتایج جستجو از       •

 شوید. PubMedوارد سایت        •

 جستجوی خود را انجام دهید.        •

 انتخاب نمایید.منابع مورد نظر خود را از نتایج جستجو        •

  Choose destinationرا کلیک نمایید. از قسمت    Send toدر بالای صفحه جستجو، گزینه          •

را کلیک نمایید. در این قسمت از   Creat fileرا انتخاب و سپس گزینه    Citation manager  گزینه

  openجام گیرد. گزینه بر روی فایل مورد نظر ان  Saveیا    Openشما سوال می شود که کدام عملیات  

به صورت مستقیم به کتابخانه شخصی    Pubmedرا انتخاب نمایید. به این صورت رفرنس های انتخابی از  

 اندنوت منتقل می گردد.  

 Google Scholarانتقال نتایج جستجو از سایت     •

انجام گرفته کافیست در زیر هر رفرنس بر روی    Google Scholarبا توجه به تنظیماتی که بر روی          •

کلیک نمایید. در این قسمت به جای ذخیره کردن رفرنس گزینه    Import into Endnoteگزینه  

Open    کتابخانه شخصی در به  به صورت مستقیم  نظر  مورد  رفرنس  این صورت  به  نمایید  انتخاب  را 

 اندنوت منتقل می گردد.  



 

    Web of science (ISI) انتقال نتایج جستجو از سایت       •

ابتدا جستجوی خود را در این پایگاه های اطلاعاتی انجام می دهیم، بعد از انتخاب رفرنس های مورد          •

 را انتخاب نمایید.   Export> Endnote desktopنظر گزینه 

•         در این پنجره گزینهExport   .را کلیک نمایید 

 •         منابعی که انتخاب نموده اید به صورت مستقیم به کتابخانه شخصی در اندنوت منتقل می

توجه داشته باشید که کتابخانه شخصی شما در این حالت باید باز باشد، رفرنس های انتخاب شده به زیر   .شود

  .وارد می شود  Imported reference گروه  

 Scopusانتقال نتایج جستجو از سایت       •

ابتدا جستجوی خود را در این پایگاه های اطلاعاتی انجام دهید، بعد از انتخاب رفرنس های مورد نظر          •

 را کلیک نمایید   Exportدر بالای صفحه جستجو گزینه 

•          در این پنجره گزینهRIS format    را انتخاب نمایید. کلیدExport    را بزنید. در ادامه می توانید

  Importآنرا از طریق    Pubmedا ذخیره نمایید و مانند مراحل گفته شده در بخش  موارد انتخاب شده ر

کلید   زدن  با  یا  و  نمایید،  منتقل  کتابخانه شخصی خود  به صورت    Saveبه جای    Openبه  را  آنها 

 .مستقیم به اندنوت منتقل نمایید 

 کتابخانه شخصی جستجو در پایگاه اطلاعاتی از طریق نرم افزار/ انتقال به         . ۴

به کمک این شیوه می توانید به سادگی و بدون نیاز به مرورگر اینترنتی به جستجو در میان پایگاه های اطلاعاتی  

بپردازید. بدیهی است که در هنگام استفاده از این شیوه باید به اینترنت متصل باشید. برای استفاده از این روش  

  Online Searchز کنید. در منوی سمت چپ صفحه گزینه  ابتدا کتابخانه شخصی تان در نرم افزار اندنوت را با

در این قسمت قرار   ISIو   PubMedقرار دارد. تعدادی از پایگاه های اطلاعاتی که استفاده بیشتری دارند نظیر 

را انتخاب نمایید. فهرستی از    moreدارد. در صورتی که قصد انجام جستجو در پایگاه دیگری را دارید، گزینه  

ها کلید    پایگاه  روی  بر  کنید  انتخاب  را  خود  نظر  مورد  اطلاعاتی  پایگاه  شود.  می  داده  نمایش  ای  پنجره  در 

Choose  .کلیک نمایید 



 

 
 

یکی از پایگاه ها را انتخاب نمایید. پنل جستجو در بالای صفحه کتابخانه شخصی شما قرار دارد. گام بعدی وارد  

کردن منابع مورد نیاز است. بعد از جستجوی کلید واژه مورد نظر، نتایج  کردن کلید واژه )های( جستجو برای پیدا  

جستجو در قسمت پنل رفرنس نمایش داده می شود. شما می توانید از بین نتایج جستجو انتخاب نمایید و با  

 رفرنس های مورد نظر را به لیست رفرنس ها اضافه نمایید. استفاده از گزینه 

  



 

 
 

ظاهر    Pubmedو هم در گروه موقت اتصال پایگاه     All Referencesا دانلود و هم در منابع در کتابخانه شم

 به صفر بر می گردد.  Pubmedمی شوند. وقتی شما کتابخانه را می بندید تعداد منابع موجود در گروه موقت  

 در قالب یک فولدر برای ساختن یک رکورد جدید  PDFو یامجموعه ای از فایلهای  PDF. انتقال یک فایل  ۵ 

موجود    DOI1[۱]را، با استفاده از    PDFاین قابلیت به شما اجازه می دهد یک فایل و یا مجموعه ای از فایلهای  

را با داده های    DOI، به کتابخانه شخصی خود در اندنوت منتقل نمایید. سیستم، اطلاعات  PDFدر هر فایل  

مطابقت داده و اطلاعات کتابشناختی را از این سایت   www.crossref.orgCrossref (2[۲](موجود در  

د و یک رکورد جدید در اندنوت ایجاد می کند. مسلما در زمان انتقال اطلاعات حتما باید به اینترنت  دریافت می کن

 
 

 

http://www.crossref.org/


 

نداشته باشد اطلاعات رفرنس منتقل نمی شود و فقط فایل    DOIشماره    PDFمتصل باشید. در صورتی که فایل  

PDF  .به یک رکورد متصل می شود 

 PDFمثال: انتقال یک فایل  

را انتخاب نمایید. در قسمت    File> Import> Fileکتابخانه شخصی خود را باز نمایید. از منوی          •

Import File    فایلPDF    قسمت در  نمایید.  انتخاب  اید  نموده  ذخیره  قبلا  که  را  خود  نظر  مورد 

Import Option  فیلترPDF .را انتخاب نمایید   

باشد و به اینترنت متصل    DOIرا کلیک نمایید. در صورتی که فایل شما دارای شماره    Importگزینه          •

 باشید اطلاعات فایل مورد نظر به طور کامل به کتابخانه شما منتقل می شود. 

  PDFو درگ کردن در نوار آبی بالای پنجره اندنوت فایل  PDF: می توان با انتخاب یک فایل نکته          

را به همراه اطلاعات رفرنس به پنجره اندنوت منتقل نمود. توجه داشته باشید که شرایطی که در بالا ذکر  

 شد باید وجود داشته باشد تا اطلاعات رفرنس به درستی منتقل گردد.  

 PDFی  مثال: انتقال یک فولدر از مجموعه ای از فایل ها

را انتخاب نمایید. در پنجره    Import> Folderگزینه    Fileکتابخانه شخصی خود را باز نمایید. از منوی          •

Import Folder    فولدر مورد نظر خود را که قبلا ذخیره نموده اید انتخاب نمایید. در قسمتImport 

Option    فیلترPDF    را انتخاب و گزینهImport    را کلیک نمایید. تمام فایلهایPDF    موجود در فولدر

 مورد نظر به صورت رکوردهای جداگانه به کتابخانه شخصی شما در اندنوت منتقل می شود. 

  

  
 

 

 
 

  



 

 مدیریت اطلاعات وارد شده به اندنوت

 گروه بندی منابع        . ۱

بازیابی   اطلاعات وارد شده به اندنوت را می توان به گروه های اختصاصی تقسیم بندی نمود تا در زمان استفاده، 

  .منابع راحت تر امکان پذیر باشد 

 Custom groupساختن گوه عمومی        •

 نظر را که می خواهید در یک گروه باشند انتخاب نمایید.ابتدا منابع مورد        •

منوی          • را    Create Custom Groupو سپس    Add Reference Toگزینه    Groupاز 

و سپس    Add Reference Toانتخاب نمایید و یا بر روی منابع انتخاب شده رایت کلیک نموده  

Create Custom Group  .را انتخاب کنید 

نمایید. منابع انتخاب شده در این گروه    Enterدر منوی سمت چپ نام گروه مورد نظر را وارد نموده و          •

 قرار می گیرد. 

 

 
  



 

بسازید، سپس  Custom groupشما می توانید  : Smart Groupساختن گروه هوشمند       •

زمانی که منابع جدید به کتابخانه شخصی شما افزوده شود  نتایج جستجوی خود را در آن قرار دهید، اما 

باید گروه شخصی خود را به صورت دستی روزآمد نمایید. برای اینکه این گروه به صورت خودکار  

روزآمد شود باید یک گروه هوشمند بسازید. اساس کار گروه هوشمند بر روی استراتژی جستجو است.  

وجود دارد. ما می   "Stem cell" عداد زیادی رفرنس با کلید واژهبرای مثال در این کتابخانه شخصی ت

خواهیم گروهی بسازیم که رفرنس های مورد نظر را به ما نشان دهد و به صورت خودکار روزآمد شود.  

را   Create smart groupکلیک راست نمایید و گزینه  My Groupبرای این کار بر روی گزینه  

را انتخاب نمایید. در پنجره   Create smart groupگزینه  Groupانتخاب کنید، و یا از منوی  

Smart group  سپس استراتژی جستجوی خود را تعریف   .ابتدا یک نام برای گروه خود انتخاب نمایید

 .را کلیک نمایید تا یک گروه هوشمند ساخته شود createو کلید 

ه هوشمند جدید قرار گرفته اند. هر گاه منبع  تمام رفرنس ها با کلید واژه انتخاب شده هم اکنون در گرو

یا منابعی به کتابخانه شخصی افزوده شود گروه هوشمند به صورت خودکار روزآمد می شود.جهت ساختن 

گروههای هوشمند می توانیم بر اساس درجه اهمیتی که به هر مقاله داده ایم نیز گروه هوشمند بسازیم. 

را انتخاب و سپس گروه خود را تعریف    Ratingگزینه    Smart groupاز گزینه های موجود در پنجره  

 نماییم.

•      Group set:  برای دسته بندی گروهها در زیر یک عنوان در پنل گروه بکار می رود. برای ساختن

را انتخاب و سپس   Create group setکلیک راست نمایید و گزینه  My groupآن بر روی گزینه 

را انتخاب   Group> Create group setنام دسته گروه خود را تعیین نمایید و یا با استفاده از منوی  

  .می توانید تعدادی گروه را قرار دهید  Group setدر زیر هر   نمایید.

برای سازماندهی بهتر رفرنس های اندنوت می   :(Combination group)گروه ترکیبی       •

ایجاد نمایید. برای   AND, OR, NOTتوانید ترکیبی از گروه ها با استفاده از عملگرهای منطقی  

 :ساخت گروه ترکیبی 

 <Groupو یا با استفاده از منوی    Create from groupگزینه    My group. با کلیک راست بر روی  ۱

Create from group اب نمایید.را انتخ 



 

 . در پنجره ای که باز می شود نام گروه ترکیبی را انتخاب نمایید.۲

گروه های مورد نظر خود را انتخاب کنید و عملگر منطقی    "Include reference in". در قسمت  ۳

 مورد نظر را انتخاب نمایید.

را انتخاب نمایید تا تغییرات ذخیره گردد. گروه ترکیبی شما در پنل گروه ظاهر می    Create. گزینه  ۴

 شود. گروه شامل موارد مشترک با توجه به انتخاب شما می باشد. 

 ناخواستهحذف منابع        . ۲

و کلیک می توانید منابع را انتخاب    Ctrlبرای حذف منابع ابتدا آنها را انتخاب )با پایین نگه داشتن کلید   

، و یا با کلیک راست و  Move references to trash گزینه    Referencesکنید( نمایید. سپس از منوی  

منابع انتخاب شده را از کتابخانه حذف نمایید. همچنین می    Move references to trashانتخاب گزینه  

قرار می    Trashآنها را حذف نمود. منابع حذف شده در گروه    trashتوان با درگ کردن موارد انتخاب شده به  

 Emptyگزینه    Referencesگیرد و کاملا حذف نمی شود. برای اینکه منابع کاملا حذف شود از منوی  

trash   با کل یا  بر روی  و  انتخاب گزینه    Trashیک راست  را به طور کامل حذف    Empty trashو  منابع 

 نمایید. 

 Endnote Libraryیافتن متن کامل منابع موجود در         .۳

از بالای پنل رفرنس کلیک نمایید و یا روی منابع  ابتدا منابع مورد نظر را انتخاب نمایید. سپس آیکون 

 را انتخاب کنید.  Find Full Textانتخاب شده کلیک راست و گزینه  

کلیک کنید تا جستجوی متن کامل آغاز شود.   OKدر اینجا اندنوت قانون کپی رایت را یادآور می شود. روی  

را مشاهده می کنید که    Searching، گروه  Find Full Textدر سمت چپ صفحه، زیر مجموعه گروه  

نشان می دهد جستجو در حال انجام است. زمانی که جستجو به پایان رسید، براساس نتایج شما ممکن است 

 مشاهده نمایید.  Find Full Textترکیبی از سه نوع گروه در زیر 



 

۱.       Found PDF :  منابعی را که فایلPDF  .آنها یافت و به منبع متصل گردد نشان می دهد 

۲ .       Found URL :موجود باشد نشان می دهد.    منابعی که آدرس اینترنتی آنها 

۳ .     Not Found :  منابعی که نه آدرس اینترنتی و نه فایلPDF    آنها موجود نباشد در این گروه قرار

 می گیرند.

  

مقاله را به منبع متصل    PDFاگر متن کامل مقاله در پایگاه هایی که رایگان هستند، در دسترس باشد، فایل 

می نماید. به یاد داشته باشید الگوریتمی که به این منظور توسط نرم افزار مورد استفاده قرار می گیرد شامل  

همه پایگاه های رایگان نمی شود لذا در صورتی که نرم افزار نتواند متن کامل مقاله را بیابد به معنی آن نیست  

شما می توانید مطابق معمول متن کامل مقاله خود را با مراجعه به پایگاه داده  که متن مقاله موجود نمی باشد.  

 های مختلف دانلود نمایید و به منبع مزبور در کتابخانه شخصی متصل نمایید. 

چگونه متن کامل مقاله، یا فایل های دیگر مرتبط با یک منبع را به اطلاعات آن منبع ضمیمه      

 کنیم؟ 

 کتابخانه شخصی خود را در اندنوت باز کنید.        •

 در پنل تب ها کلیک نمایید. Attach fileبر روی منبع مورد نظر خود کلیک نمایید. بر روی گزینه         •

 کلیک نمایید.   Openدر پنجره ای که ظاهر می شود فایل مورد نظر را بیابید و بر روی کلید        •

،  "آیا می خواهید تغییرات را ذخیره نمایید؟"نبع دیگر، از شما سوال می شود که  با کلیک بر روی یک م         •

 تغییرات ذخیره می شود.  Yesبا انتخاب گزینه  

  

فایل های ضمیمه شده همراه با فایل اصلی کتابخانه شخصی تان ذخیره می شود. به این ترتیب فایل  

 ضمیمه شده منابع را همیشه در اختیار دارید. 



 

کتابخانه شخصی شماست، لذا   "Data"یادآوری است که محل ذخیره فایل های ضمیمه پوشه  لازم به  

را به همراه فایل    "Data"به یاد داشته باشید برای دسترسی به فایل های ضمیمه شده همیشه پوشه  

دیگر  کتابخانه خود داشته باشید و در صورت نیاز به انتقال کتابخانه شخصی از یک کامپیوتر به کامپیوتر  

 را نیز انتقال دهید. "Data"پوشه 

 رتبه بندی منابع موجود در لیست کتابخانه شخصی        .۴

شما می توانید به هر یک از منابع موجود در کتابخانه شخصی خود بر اساس میزان اهمیت رتبه ای اختصاص  

را    Ratingدهید. برای این کار ابتدا یکی از منابع را انتخاب نموده و روی آن کلیک راست نمایید. گزینه  

 انتخاب و امتیاز منبع مورد نظر را تعیین نمایید.  

 ( به منابع Mark as read/unread) برچسب به عنوان خوانده شده یا نشده اعمال یک      . ۵

شما می توانید به منابع موجود در کتابخانه شخصی یک برچسب اختصاص دهید به منظور پیگیری اینکه   

 Markکدام منابع در طول تحقیق توسط شما بررسی شده اند. روی منبع مورد نظر کلیک راست و گزینه  

as read   .را انتخاب نمایید. منابع خوانده شده به صورت کم رنگ تر در لیست مشاهده می شوند 

 به روز رسانی رفرنس ها در اندنوت 

برای این کار ابتدا بر روی رفرنس مورد نظر دوبار کلیک میکنیم تا وارد صفحه ویرایش رفرنس شویم.  از منوی  

Reference > Find reference update   ی کنیم. در اینجا پنجره ای باز می شود که در قسمت  را انتخاب م

سمت چپ تغییرات و به روز رسانی موجود و در قسمت سمت راست اطلاعات رفرنس وارد شده را نشان می دهد.  

می توانید تغییرات را اعمال نمایید. توجه    Update empty fieldsیا    Update all fieldsبا انتخاب گزینه  

حتما فیلدهای نویسنده، عنوان،    Updateباشید که این عمل همیشه درست انجام نمی گیرد. قبل از انجام    داشته 

 سال را چک نمایید و از صحیح بودن اطلاعات بازیابی شده اطمینان حاصل نمایید.



 

 
 

  

  

  

 آشنایی با نوار ابزار اندنوت در محیط ورد

افزار ورد کافیست این نرم افزار را بر روی کامپیوتر خود نصب نمایید. زبانه  برای مشاهده این نوار ابزار در نرم  

 در کنار بقیه زبانه ها قرار می گیرد و با کلیک بر روی آن نوار ابزار اندنوت باز می شود.   اندنوت

 

را باز نمایید. در پایین صفحه    Add-Insو زبانه      Word Option در صورتی که این زبانه در ورد نبود، پنجره  

 را بزنید.  Goکلید 



 

 
 

را    OKرا انتخاب نمایید و کلید    Endnote Cite while you writeگزینه    COM Add-Insدر پنجره  

 افزوده می شود.   در صفحه ورد    بزنید. به این ترتیب زبانه اندنوت

 چگونه در حین نوشتن مقاله، ارجاع ها را وارد کنیم؟ 

در محیط ورد می توانید هنگام تایپ دست     Cite While You Write (CWYW)استفاده از ویژگیبا  

نوشته خود، استنادهای درون متنی را وارد کنید و البته به طور خودکار فهرست منابع پایان متن نیز ساخته می  

 شود. برای این کار می توانید به یکی از دو روش زیر عمل نمایید: 

 :در محیط ورد  Insert citationیکون استفاده از آ .1

 متن مورد نظر خود را که در نرم افزار ورد تایپ شده، باز نمایید.       •

  Insert citationمکان نما را دقیقا به جایی ببرید که ماخذ باید درج شود، از نوار ابزار اندنوت  آیکن          •

 را انتخاب نمایید. Insert Citationگزینه 



 

 
   
 

باز می شود. یک جستجوی کلید واژه ای انجام دهید   Find & Insert my referencesصفحه        •

را کلیک نمایید. جستجو در کتابخانه شخصی شما انجام شده و نتایج جستجو به نمایش    Findو گزینه  

 کلیک نمایید. Insertدر می آید. منبع )های( مورد نظر خود را انتخاب و روی کلید 

مآخذ در محل پیش بینی شده درج خواهد شد و اطلاعات کامل کتابشناختی مقاله در پایان متن ظاهر          •

   می شود. 

 در محیط اندنوت  Insert citation . استفاده از آیکون ۲ 

در متن مقاله در حال تایپ خود، مکان نما را دقیقا به جایی ببرید که ماخذ باید درج شود. سپس روی         •

 از نوار ابزار اندنوت کلیک نمایید.  Go to Endnoteآیکون 

در لیست رفرنس های موجود در کتابخانه شخصی خود، رفرنس )های( مورد نظر خود را بیابید و با          •

و کلیک می توانید بیش از یک رفرنس را    Ctrlرا انتخاب نمایید. )با گرفتن کلید    کلیک روی آن، آن

 انتخاب نمایید.(

، مآخذ در محل پیش بینی شده درج خواهد شد و  Insert citation اکنون با کلیک بر روی آیکون          •

 اطلاعات کامل کتابشناختی در پایان متن ظاهر می شود. 



 

 
   

  

  

 رفرنس نویسی (Style) سبکانتخاب یک 

اندنوت این امکان را به شما می دهد تا فرمت استنادها و رفرنس های پایان متن خود را بر اساس نیازتان تغییر  

 سبک مورد نظر خود را انتخاب نمایید.  Styleدهید. برای اینکار در تب اندنوت در بالای پنجره ورد، از گزینه 

 

سبک نوشتن منابع و مآخذ وجود دارد. نصب معمولی نرم افزار تنها مشهورترین  سبک    ۴۵۰۰بیش از    نکته:    

 ها را شامل می شود.  

 مورد نظر در این قسمت موجود نبود می توانید به روشهای زیر عمل کنید:   styleدر صورتی که 

مراجعه     www.endnote.comنبود می توانید به سایت    Styleدر صورتی که سبک مورد نظر در لیست        .۱

 را انتخاب نمایید.   Output styles> add output styleشده و گزینه   Downloadکنید. وارد تب 

ذخیره کردن    را کلیک نمایید. برای  Searchوارد کرده و گزینه   Keywordنام ژورنال مورد نظر را در قسمت  

Style  در مقابل نام ژورنال گزینه ،Download    وجود دارد. روی آن کلیک نمایید و  فایل مورد نظر را در درایو



 

C  فولدر ،program files فولدر   ، فولدر اندنوت ،Styles    ذخیره نمایید. به این صورت سبک مورد نظر به

 لیست سبک های موجود در اندنوت افزوده می شود. 

: در این روش ابتدا شما باید صفحه راهنمای نویسندگان در ژورنال مورد نظر و بخش مربوط  styleویرایش        .۲

به نحوه نوشتن رفرنس ها را مطالعه نمایید. به این ترتیب شما می توانید شبیه ترین استایل به استایل مورد نظر  

باشد، با   NLMرد نظر ما مشابه استایل  را انتخاب و در مرحله بعد آن را ویرایش نمایید. برای مثال اگر استایلی مو

قرار بگیرد و به صورت    [ ]این تفاوت که عدد رفرنس درون متنی به جای قرار گرفتن در پرانتز باید در براکت  

بالانویس باشد، و همچنین در رفرنس های پایان متن نام ژورنال به صورت ایتالیک باشد و یا فیلدی اضافه یا کم  

 یک استایل جدید بسازیم. برای اینکار: NLMنیم با ویرایش استایل داشته باشد، می توا

 را انتخاب می کنیم.   .. Tools> output style> Editاز منوی        •

 
 

در پنجره ای که باز شده در ستون سمت چپ الگوی نوشتن استایل مشخص گردیده. ابتدا باید به          •

برویم تا رفرنس درون متنی را تعریف کنیم، در پنجره سمت راست    Citations> templatesقسمت  

مشخص می کند که رفرنس درون متنی به چه صورت نمایش داده شود. برای مثال   Citationsدر زیر 



 

تبدیل می کنیم سپس آن را انتخاب کرده و از    [  ]را به  (Bibliographic number)دا پرانتز  ابت

 را انتخاب می کنیم تا به صورت بالا نویس قرار بگیرد.  نوار ابزار بالا گزینه  

می رویم. در    Bibliography> Templatesبرای تغییر قالب رفرنس های پایان متن به قسمت          •

این قسمت الگوی نوشتن رفرنس برای انواع مختلف رفرنس مانند کتاب، ژورنال، صفحه وب و .... نوشته  

 شده است. در این قسمت هر تغییری که لازم باشد انجام می دهیم.  

از شما سوال می   Edit styleپنجره   Xرا انتخاب و یا با بستن   File> save asدر پایان از منوی          •

 پرسد که آیا تغییرات را ذخیره می نمایید.  

یک اسم جدید برای استایل انتخاب می کنیم و تغییرات را ذخیره می نماییم. به این ترتیب یک استایل          •

 جدید به لیست استایل ها افزوده می شود.  

: در صورتی که تهیه استایل مورد نظر از هیچ یک از راه های بالا امکان پذیر نباشد، شما ساختن استایل جدید      .۳

 می توانید یک استایل جدید با قالب مورد نظر بسازید. مراحل کار به این صورت است:  

 را انتخاب نمایید.  Tools> Output style> New Styleاز منوی        •

 که می توانید مرحله به مرحله مشخصات استایل را تعریف نمایید.پنجره ای باز می شود         •

  About this style, Citations, Bibliographyاز ستون سمت چپ قسمتهای مختلف مانند          •

 و .... را انتخاب می کنیم و در ستون سمت راست الگوی مورد نیاز در هر فیلد را تعریف می نماییم.  



 

  

 

  Documents: فایل استایلی که جدید ساخته اید )به روش ویرایش و یا ساختن استایل جدید( در  نکته      

 می باشد. ens.در پوشه اندنوت استایل ذخیره می شود. پسوند این فایل  

  

 ویرایش و مدیریت استنادها در ورد   

با استفاده از این بخش می توانید استنادهای درون متنی و پایان متن را در محیط ورد ویرایش و مدیریت نمایید.  

را انتخاب نمایید. پنجره ای باز می شود که تمام    Edit & Manage Citationsاز نوار ابزار اندنوت گزینه  

 هر منبع می توانید در موارد زیر استفاده نمایید.  منابع استفاده شده در متن را نمایش می دهد. از منوی آبشاری

 Remove Referencesحذف یک ماخذ      .۱

 Insert Referencesاضافه نمودن ماخذ       .۲

  Edit Library Reference ویرایش منبع در کتابخانه شخصی     .۳



 

 : نکته

در صورتی که در هر یک از منابع موجود در کتابخانه شخصی ویرایش و تغییری انجام گرفت، بعد از ویرایش و  

، در فایل ورد تغییرات را در مآخذ  Update Citation & Bibliographyذخیره آن با کلیک بر روی گزینه  

 موجود در متن اعمال نمایید.  

 
 

گزینه      ✓ اندنوت  تب  کلید    Onباید    Instant formattingدر  تا   & Update Citationباشد 

Bibliography   .فعال شود 

 

  

:  فایل ورد که رفرنس های آن با استفاده از اندنوت تهیه گردد، به فایل اندنوت متصل است. به این ترتیب  نکته

می توانید هر تغییری در آن اعمال نمایید )مانند تغییر استایل، اضافه و یا حذف نمودن رفرنس و ...(. برای اینکه  

 <Convert citation & bibliography گزینه   اتصال فایل ورد را از اندنوت قطع نمایید. از تب اندنوت 

Convert to plain text  را انتخاب نمایید. از شما سوال می شود که آیا ادامه می دهید. با کلیک کردنOK  

 یک فایل جدید ساخته می شود که مشابه فایل اول است ولی اتصال آن از اندنوت قطع شده است. 

 

 



 

 تهیه خروجی از لیست رفرنس ها 

 تهیه خروجی از اندنوت به ورد:     . ۱

 برای این کار ابتدا رفرنس های مورد نظر و یا تمام رفرنس ها را انتخاب می نماییم.       •

 و یا از نوار ابزار گزینه را انتخاب می کنیم.   File> Exportاز منوی         •

  Save as typeدر پنجره ای که باز می شود ابتدا نام فایل را  انتخاب می کنیم. سپس در قسمت          •

قرار می دهیم. و در پایان استایل مورد نظر را انتخاب می نماییم و   Rich text formatشکل فایل را  

 را می زنیم.   Saveکلید 

 ساس استایل مورد نظر تهیه می شود.به این ترتیب یک خروجی از رفرنس های انتخابی بر ا       •

 تهیه خروجی از فایل ورد به اندنوت     . ۲

گاهی اوقات ممکن است فایل اندنوت در دسترس نباشد و یا فقط فایل ورد )که به اندنوت متصل بوده است(  

رفرنس های  در اختیار شما باشد. می توانید با استفاده از همین فایل ورد یک کتابخانه اندنوت بسازید و از  

 خروجی تهیه نمایید. برای این کار: 

 را انتخاب کنید. Export to Endnote> Export traveling libraryاز تب اندنوت گزینه         •

 

  



 

پنجره جدیدی باز می شود که می توانید کتابخانه اندنوت موجود بر روی کامپیوترتان را انتخاب کنید          •

 کتابخانه اندنوت جدید بسازید.و یا یک 

 را می زنیم. OKبعد از انتخاب یکی از موارد بالا کلید         •

 کتابخانه اندنوت در مکان مورد نظر ذخیره می شود.        •

را نشان می دهد. به این ترتیب یک کتابخانه اندنوت از رفرنس های موجود    Export completeپیام          •

 ه می شود. در فایل ورد ساخت

 دسته بندی کردن رفرنس ها در ورد 

این قابلیت به شما اجازه می دهد رفرنس ها را در فایل ورد دسته بندی موضوعی نمایید. اگر لازم است رفرنس  

های  خود را به بخشهای مختلف تقسیم کنید ، این بسیار مفید است. زمانی که اندنوت رفرنس های پایان متن  

 کند، استنادها را بر اساس دسته بندی سازماندهی می کند. جهت دسته بندی کردن رفرنس ها: ورد را اضافه می 

 را انتخاب کنید.  Categorize referencesاز تب اندنوت در ورد گزینه      .۱

 را انتخاب نمایید. Configure categoriesگزینه      .۲

ر      .۳ ها  رفرنس  توان  می  شود  می  باز  که  ای  پنجره  قسمت  در  در  نمود.  بندی  گروه   Categoryا 

headings    با کلیک راست بر روی هر سرعنوان می توان نام آن را عوض کرده، و با درگ کردن رفرنس

 های موجود در پنجره سمت راست به هر سرعنوان، می توان آن را دسته بندی کرد. 

 دسته بندی بر روی رفرنس ها اعمال می گردد.  OKبا زدن کلید       .۴



 

 
 

  

 


